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Welcome

Welcome to the Tektronix 100G-TXE, an Tektronix oscilloscope application software that addresses 100GBASE-CR4, 100GBASE-KR4,
and CAUI-4 standards of IEEE. These three electrical standards make up the backbone of the current 100G Ethernet industry, and the
TekExpress 100G-TXE automation test solution facilitates turnkey electrical transmitter validation of most 100G Ethernet systems today.

The 100G-TXE solution specifically targets Annex 83 of the IEEE 802.3bm standard as well as sections 92 and 93 of the IEEE 802.3bj
specification. These tools allow quick verification to these IEEE electrical standards, while offering comprehensive test automation, results
margining, data logging, and results reporting in an advanced testing framework.

Key features of TekExpress 100G-TXE include:

• 100G-TXE offers Transmitter 100GBASE-CR4 time domain transmitter characterization, tracking Table 92-6 Transmitter characteristics
at TP2 from the IEEE 802.3bj cabled I/O specification. This offers a checklist approach to performing all jitter, Linear impulse response
pulse peak and Signal to Noise and Distortion Ratio measurements, as well as basic AC parametric and timing operations.

• 100G-TXE also incorporates 100GBASE-KR4 time domain transmitter characterization, tracking Table 93-4 Transmitter characteristics
at TP0a from the IEEE 802.3bj backplane specification. While the measurements are identical to 100GBASE-CR4, the electrical limits
for 100GBASE-KR4 are more stringent.

• 100G-TXE includes a third electrical test suite, for Annex 83 of IEEE 802.3bm, tracking Chip-to-module 100 Gb/s four-lane Attachment
Unit Interface (CAUI-4), Table 83E-1 at TP1a and TP4. The user can characterize the DUT for Host output and Module output by
selecting the required test points. The CAUI-4 support offers advance CTLE scanning provisions to find optimal eye opening/width.

Welcome
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Getting help and support

Product documents

Use the product documents for more information on the application functions, understand the theory of operation, how to remotely program
or operate the application, and do other tasks.

Table 1: TekExpress Application documents

To learn about Use this document
How to use the application

How to remotely control the instrument
TekExpress <Application Name> Help

PDF version of this document can be downloaded from www.tek.com/downloads

Compiled HTML (CHM) version is integrated with the application. Press F1 key from the
keyboard to start the help.

Tektronix Part Number: 077-xxxx-xx

Conventions
This application help uses the following conventions:

• The term "Application," and "Software" refers to the TekExpress Application.
• The term “DUT” is an abbreviation for Device Under Test.
• The term “select” is a generic term that applies to the two methods of choosing a screen item (button control, list item): using a mouse

or using the touch screen.
• A Note identifies important information.

Table 2: Icons used in the help

Icon Description
This icon identifies important information

This icon identifies conditions or practices that could result in loss of data.

This icon identifies additional information that will help you use the application more
efficiently.

Getting help and support
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Technical support
Tektronix values your feedback on our products. To help us serve you better, please send us your suggestions, ideas, or comments on
your application or oscilloscope. Contact Tektronix through mail, telephone, or the Web site. See Contacting Tektronix at the front of this
document for contact information.

When you contact Tektronix Technical Support, please include the following information (be as specific as possible): 

General information
• All instrument model numbers
• Hardware options, if any
• Modules used
• Your name, company, mailing address, phone number, FAX number
• Please indicate if you would like to be contacted by Tektronix about your suggestion or comments.

Application specific information
• Software version number
• Description of the problem such that technical support can duplicate the problem
• If possible, save the setup files for all the instruments used and the application
• If possible, save the TekExpress setup files, log.xml, *.TekX (session files and folders), and status messages text file

Getting help and support
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Getting started
Hardware requirements

Minimum system requirements
The following table shows the minimum system requirements to install and run the TekExpress 100G-TXE solution. 

Table 3: System requirements

Component Description

Oscilloscope • Tektronix DPO70K series scope

• Opt DJA and DJAN

Processor Same as the oscilloscope

Operating System Same as the oscilloscope:

Memory Same as the oscilloscope

Hard Disk Same as the oscilloscope

Display Super VGA resolution or higher video adapter (800 x 600 minimum video resolution for small fonts or
1024 x 768 minimum video resolution for large fonts). The application is best viewed at 96 dpi display
settings 1

Firmware • Frimware Version: 10.6.0 or above

Software • IronPython 2.7.3 installed

• PyVisa 1.0.0.25 installed

• Microsoft .NET 4.0 Framework

• Microsoft Internet Explorer 7.0 SP1 or greater, or other Web browser for viewing reports

• Adobe Reader software 7.0 or greater for viewing portable document format (PDF) files

Instruments and accessories required
TekExpress100G-TXE application is launched on DPO70K series scope. The following table lists the instruments and accessories required
for this application. 

1 If TekExpress is running on an instrument that has a video resolution less than 800x600, connect and configure a second monitor to the instrument.

Getting started
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Table 4: Instruments and accessories required for 100G-TXE application

Instrument/Accessory Model number Quantity

Oscilloscope DPO72304SX, DPO72304DX, MSO72304DX, DPO72504DX,
MSO72504DX, DPO73304SX, DPO73304DX, MSO73304DX,
DPO72504SX, DPO75002SX, DPO75902SX, DPO77002SX, DPS75004SX,
DPS75904SX, DPS77004SX

1

Adapter 2 Broadband Balun with bandwidth >= 40 GHz 1

Cables Compatible SMA cables with bandwidth greater than 40 GHz for connecting
single ended sources ATI channel.

1

Fixtures • Host compliance board for CAUI4 at TP1a and CR4 at TP2

• Module compliance board for CAUI4 at TP4

• Transmitter test fixture for KR4 at TP0a 3

1

DC Blocks Compatible DC block with bandwidth range 50 KHz to 65 GHz 2

Attenuator 3, 6, or 10 dB attenuators 2

Probes 4 Tektronix P7600 or P7700 series 1

Software requirements

Downloading and installing the software
Complete the following steps to download and install the latest TekExpress <Application Name> application.

1. Go to www.tek.com.
2. Click Downloads. In the Downloads menu, select DOWNLOAD TYPE as Software and enter the application name in the MODEL OR

KEYWORD field and click SEARCH.

3. Select the latest version of software and follow the instructions to download the software. Copy the executable file into the
oscilloscope.

4. Double-click the executable and follow the on-screen instructions.

The software is installed at C:\Program Files\Tektronix\TekExpress\TekExpress <Application
Name>.

5. Select from the Oscilloscope menu, to open the application.

2 Required to operate in differential mode for single stack ATI scopes.
3 If required, De-Embed the fixtures using filter files.
4 Required to acquire signal at TP0a test point for KR4 suite.

Getting started
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Activate the license
Activate the license using the Option Installation wizard in the TekScope application:

1. In the TekScope application menu bar, click Utilities > Option Installation. The TekScope Option Installation wizard opens.
2. Push the F1 key on the oscilloscope keyboard to open the Option Installation help topic.
3. Follow the directions in the help topic to activate the license.

View software version and license key details
To view version information of the application, click Options > About TekExpress.

Getting started
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Setting up the test environment

Compensate the signal path
Use the following procedure to compensate the internal signal acquisition path. Perform this procedure if the ambient temperature has
changed more than 5 °C (9 °F) since you performed the last signal path compensation. Perform the signal path compensation once a
week. Failure to do so may result in the instrument not meeting warranted performance levels. 

1. Power on and wait for the instrument to complete its warm up period before continuing with this procedure.
2. Disconnect any probes you have connected to the input channels.
3. Set the instrument to Menu mode.
4. Select Instrument Calibration from the Utilities menu.
5. Note any instructions that appear in the resulting control window.
6. Click Run SPC to begin the procedure. The procedure may take several minutes to complete.
7. Verify that the Status changes to Compensated after the procedure is complete. If the Calibration Status field indicates anything other

than Compensated, see Signal Path Compensation Status for information on the readout and recommended action.

Note: When making measurements at vertical scale settings less than or equal to 5 mV, you should perform the signal path
compensation at least once a week. Failure to do so may result in the instrument not meeting warranted performance levels at
those volts/div settings.

Equipment connection diagram
Click Setup > Test Selection > Schematic to view the equipment setup diagram(s). 

Figure 1: CAUI4 TP1a (Single ended)

Setting up the test environment
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Figure 2: CAUI4 TP1a (Differential)

Figure 3: CAUI4 TP4 (Single ended)
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Figure 4: CAUI4 TP4 (Differential)

Figure 5: CAUI4 Eye Width / Eye Height TP1a (Single ended)
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Figure 6: CAUI4 Eye Width / Eye Height TP1a (Differential)
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Figure 7: CAUI4 Eye Width / Eye Height TP4 (Single ended)
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Figure 8: CAUI4 Eye Width / Eye Height TP4 (Differential)

Figure 9: CR4 TP2 (Single ended)
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Figure 10: CR4 TP2 (Differential)

Figure 11: KR4 TP0a (Single ended)
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Figure 12: KR4 TP0a (Differential)

Deskew
If skew is present between positive and negative channels, then the channels need to be deskewed before being used for waveform
measurements. TekExpress 100G-TXE provides support for channel deskew and attenuation using the following method:

1. Determine what the skew is for each channel.
2. From the TekScope menu, select Vertical > Deskew.
3. In the Deskew/Attenuation window, click the channel (1 – 4) button for the first channel to be deskewed.
4. Click in the Ch(x) Deskew Time entry field and enter the skew. The skew can be +ve or –ve.
5. Click the channel button for the next channel and repeat step 4.
6. After entering the skew for all the channels that require it, from the Options menu in TekExpress 100G-TXE, select Deskew.
7. In the Deskew dialog box, select the desired level:

• Less than 100 mV signal amplitude: Select this if the signal amplitude is such that the oscilloscope’s vertical setting is less than
100 mV/division.

• 100 mV or greater signal amplitude: Select this if the signal amplitude is such that the oscilloscope’s vertical setting is greater
than 100 mV/division.

Setting up the test environment
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Figure 13: Deskew

8. Click Set on Scope to set the stored deskew and attenuation values on oscilloscope.
9. Click Read from Scope to read the deskew and attenuation values from the oscilloscope.
10. Click View values to view the deskew, attenuation, and bandwidth values.
11. When the status in the dialog box indicates the deskew is finished, click Close.

Figure 14: Deskew-View values

Each input channel has its own deskew settings. Deskew compensates individual channels for probes or cables of different lengths. The
instrument applies the delay values after each completed acquisition. The deskew values are saved as part of the instrument setup. The
deskew values for the selected channel are retained until you change the probe, you restore a saved setup, or you recall the factory setup.

Note: If you perform the de-embed settings, then performing the Deskew and Attenuation settings are not required.

Search instruments connected to the application
Use the TekExpress Instrument Control Settings dialog box to search the instruments (resources) connected to the application. The
application uses TekVISA to discover the connected instruments.

Note: The instruments required for the test setup must be connected and detected by the application, before running the test.

To refresh the list of connected instruments:

1. Select Options > Instrument Control Settings.
2. In the Search Criteria section of the Instrument Control Settings dialog box, select the connection types of the instruments to

search. Instrument search is based on the VISA layer, but different connections determine the resource type, such as LAN, GPIB, and

Setting up the test environment
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USB. For example, if you choose LAN, the search will include all the instruments supported by the TekExpress that are communicating
over the LAN.

3. Click Refresh. The TekExpress application searches for the connected instruments.

Search status of the instruments connected to LAN

4. When the search is complete, a dialog box lists the instrument-related details based on the search criteria. For example, for the Search
Criteria as GPIB, the application displays all the GPIB instruments connected to the application.

TekExpress Instrument Control Settings window.

The details of the instruments are displayed in the Retrieved Instruments table. The time and date of instrument refresh is displayed in
the Last Updated field.

Running tests
Select tests, set acquisition parameters, set configuration parameters, set preferences parameters, and click Start to run the tests. While
tests are running, you cannot access the Setup or Reports panels. To monitor the test progress, switch between the Status panel and the
Results panel. 

While the tests are running, other applications may display windows in the background. The TekScope application takes precedence over
other applications, but you can switch to other applications by using Alt + Tab key combination. To keep the TekExpress 100G-TXE
application on top, select Keep On Top from the TekExpress Options menu.

The application displays report when the tests execution is complete.

Prerun checklist
1. Make sure that the instruments are warmed up (approximately 20 minutes) and stabilized.
2. Perform compensation: In the oscilloscope main menu, select Utilities > Instrument Compensation. Click Help in the compensation

window for steps to perform instrument compensation.

Setting up the test environment
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Starting the application
To start the TekExpress 100G-TXE, select Analyze > TekExpress 100G-TXE from the oscilloscope menu bar.

During start, a "My TekExpress" folder is created in the Documents folder of the current user and gets mapped to "X" drive. When the
application is closed properly, the "X" drive gets unmapped. Session files are then stored inside the X:\100G-TXE folder. If this file is
not found, the application runs an instrument discovery program to detect connected instruments before starting TekExpress 100G-TXE.

To keep the TekExpress 100G-TXE application on top of any application, select Keep On Top from the options menu. If the application
goes behind the oscilloscope application, select Analyze > TekExpress 100G-TXE to bring the application to the front.

Application panels overview
TekExpress 100G-TXE solution uses panels to group Configuration, Results, and Reports settings. Click any button to open the associated
panel. A panel may have one or more tabs that list the selections available in that panel. Controls in a tab can change depending on
settings made in the same tab or another tab.

Starting the application
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Table 5: Application panels overview

Panel Name Purpose

Setup panel The Setup panel shows the test setup controls. Click the Setup button to open this panel.

Use this panel to:

• Set DUT tab parameters
• Select tests
• Set acquisition tab parameters
• Set configuration tab parameters
• Set preferences tab parameters

Status panel View the progress and analysis status of the selected tests, and view test logs.

Results panel View the summary of test results and select result viewing preferences.

Reports panel Browse for reports, save reports as specific file types, specify report naming conventions, select report
content to include (summary information, detailed information, user comments, setup configuration,
application configuration), and select report viewing options.

Application controls
This section describes the application controls.

Starting the application
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Table 6: Application control description

Item Description
Options menu Menu to display global application controls.

Test panel Controls that open tabs for configuring test settings and options.

Start / Stop button Use the Start button to start the test run of the measurements in the selected order. If prior
acquired measurements are not cleared, then new measurements are added to the existing
set.

The button toggles to the Stop mode while tests are running. Use the Stop button to abort
the test.

Pause / Continue button Use the Pause button to pause the acquisition. When a test is paused, this button changes
as Continue.

Clear button Use the Clear button to clear all existing measurement results. Adding or deleting a
measurement, or changing a configuration parameter of an existing measurement, also
clears measurements. This is to prevent the accumulation of measurement statistics or
sets of statistics that are not coherent. This button is available only on Results panel: View
summary of test results on page 42.

Note: This button is visible only when there are results data on the panel.

Application window move icon Place the cursor over the top of the application window to move the application window to
the desired location

Minimize icon Minimizes the application.

Close icon Close the application.

Table continued…
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Item Description
Mini view / Normal view Toggles the application between mini view and normal view.

Mini view displays the run messages with the time stamp, progress bar,

Start / Stop button, and Pause / Continue button.

The application moves to mini view when you click the Start button.

Options menu functions
To access the Options menu, click  in the upper-right corner of the application. It has the following selections:

Table 7: Options menu settings

Menu Function
Default Test Setup Opens a new test setup with default configurations.
Open Test Setup Opens a previously saved test setup. Displays the list of previously saved test setup file

names. Make the selection and click OK to open the test setup.
Save Test Setup Saves the current test configurations with the specified file name.
Save Test Setup As Saves the current test setup with a different file name or file type.
Open Recent Displays the recently opened test setup file names. Make the selection and click OK to

open the test setup.
Instrument Control Settings Detects, lists, and refreshes the connected instruments found on the specified connections

(LAN, GPIB, USB, Serial, Non-VISA Resources, TekLink, and VXI).

Keep On Top Always keeps the TekExpress application on top of all the applications.

Email Settings Configures email options for test run and result notifications.
Table continued…

Starting the application
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Menu Function
Deskew Loads oscilloscope channel deskew settings into the application.
Help Displays the help.
About TekExpress Displays the application name, version, and hyperlink to end the user license agreement.

Starting the application

TekExpress® 100G-TXE Compliance Solution Application Help 28



Configure email settings
Use the Email Settings utility to get notified by email when a measurement completes or produces any error condition. Follow the steps to
configure email settings: 

Figure 15: Email settings window

1. Select Options > Email Settings to open the Email Settings dialog box.
2. (Required) For Recipient email Address(es), enter one or more recipient email addresses. To include multiple addresses, separate

the addresses with commas.
3. (Required) For Sender’s Address, enter the email address used by the instrument. This address consists of the instrument name,

followed by an underscore, followed by the instrument serial number, then the @ symbol, and the email server ID. For example:
user@yourcompany.com.

4. (Required) In the Server Configuration section, type the SMTP Server address of the Mail server configured at the client location,
and the SMTP Port number, in the corresponding fields.

If this server requires password authentication, enter a valid login name, password, and host name in the corresponding fields.

Note: If any of the above required fields are left blank, the settings will not be saved, and email notifications will not be sent.

5. In the Email Attachments section, select from the following options:

• Reports: Select to receive the test report with the notification email.
• Status Log: Select to receive the test status log with the notification email. If you select this option, then also select whether you

want to receive the full log or just the last 20 lines.
6. In the Email Configuration section:

• Enter a maximum file size for the email message. Messages with attachments larger than this limit will not be sent. The default is
5 MB.

• Enter the number in the Number of Attempts to Send field, to limit the number of attempts that the system makes to send a
notification. The default is 1. You can also specify a timeout period.

7. Select the Email Test Results When complete or on error check box. Use this check box to quickly enable or disable email
notifications.

8. To test your email settings, click Test Email.
9. To apply your settings, click Apply.
10. Click Close when finished.

Starting the application
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TekExpress instrument control settings
Use the TekExpress Instrument Control Settings dialog box to search the instruments (resources) connected to the application. You
can use the Search Criteria options to search the connected instruments depending on the connection type. The details of the connected
instrument is displayed in the Retrieved Instruments window.

To access, click Options > Instrument Control Settings. Select GPIB as search criteria for TekExpress application and click Refresh.
The connected instruments displayed in the Retrieved Instruments window and can be selected for use under Global Settings in the test
configuration section. 
Figure 16: TekExpress Instrument Control Settings window

See also
Options menu functions on page 27

Starting the application
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Setup panel overview
The Setup panel contains sequentially ordered tabs that help you guide through the test setup and execution process. 

Set DUT parameters
Use the DUT tab to select parameters for the device under test. These settings are global and apply to all tests of current session. DUT
settings also affect the list of available tests in the Test Selection tab.

Setup panel overview

TekExpress® 100G-TXE Compliance Solution Application Help 31



Click Setup > DUT to access the DUT parameters: 

Table 8: DUT tab settings

Setting Description

DUT ID Adds an optional text label for the DUT to reports. The default value is DUT001. The maximum number of
characters is 32.

You cannot use the following characters in an ID name: (.,..,...,\,/:?”<>|*)

   Comments
icon (to the right of
the DUT ID field)

Opens Comments dialog box to enter text to add to the report. Maximum size is 256 characters. To enable or
disable comments appearing on the test report, see Select report options.

Acquire live
waveforms

Perform analysis on live waveforms.

Use pre-recorded
waveform files

Perform analysis on pre-recorded waveforms.

Mode • Compliance
• User Defined

Standards Test Points Specification

CAUI4 5 TP1a IEEE802.3bm, Annex 83E.3.1
TP4 IEEE802.3bm, Annex 83E.3.2

KR4 6 TP0a IEEE802.3bj, Section 93
Table continued…

5 CAUI4 (CAUI-4) is 100G chip-to-module IEEE 802.3bm interface, operating on four 25 Gb/s lanes.
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Setting Description

CR4 7 TP2 IEEE802.3bj, Section 92

Data Rate Set the data rate to be tested within the range 18 to 28.05. The default value is 25.78125

Pattern Type Select the pattern type. The available options are PRBS7, 9, 11, and 15. By default, it is PRBS9.

Source • Differential - Source as differential signal
• Single Ended -Source as single-ended signals

Crosstalk Source Select crosstalk source when cross talk generator is connected. This is applicable for Eye width and Eye height
measurements only.

See also
Select tests

Select tests
Use the Test Selection tab to select the tests. The test measurements available depends on the standards selected in the DUT tab. 

Figure 17: CAUI4 TX measurements

6 KR4 (100GBASE-KR4) is an Ethernet IEEE 802.3bj standard for 100G backplanes.
7 CR4 (100GBASE-CR4) is an Ethernet IEEE802.3bj standard for 100G over twin-axial cables.
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Figure 18: KR4 TX measurements

Figure 19: CR4 TX measurements
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Table 9: Test Selection tab settings

Setting Description

Tests Click on a test to select or unselect. Highlight a test to show details in the Test Description pane.

Test Description Shows brief description of the highlighted test in the Test field.

See also
Set acquisition tab parameters

Set acquisition tab parameters
Use Acquisitions tab to view the test acquisition parameters. The contents displayed on this tab depends on the DUT type and the tests
selected.

Note: 100G-TXE application acquires all waveforms needed by each test group before performing analysis.

Table 10: Acquisitions tab settings

Setting Description

Show Acquire Parameters Select to view the acquisition parameters.

Signal Validation Sets the application to validate acquisition signals and perform the specified action to take when acquired
signals do not meet requirements. Select the action from the list.

Setup panel overview
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TekExpress 100G-TXE saves all acquisition waveforms to files by default. Waveforms are saved in a unique folder for
each session (a session is started when you click the Start button). The folder path is X:\100G-TXE\Untitled
Session\<dutid>\<date>_<time>. Images created for each analysis, CSV files with result values, reports, and other
information specific to that particular execution are also saved in this folder.

Saving a session moves the session file contents from the Untitled Session folder to the specified folder name, and changes the session
name to the specified name.

Set configuration tab parameters
Use Configuration tab to view and configure the Global Settings and the measurement configurations. The Global Settings and the
measurements with configurations available in this tab depends on the Standards selected in the DUT tab. 

Figure 20: Configuration tab: Global Settings

Table 11: Configuration tab settings

Setting Description

Compliance Mode Select compliance mode. By default Compliance Mode is selected.

User Defined Mode Select user defined mode

Global Settings

Table continued…
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Setting Description

Instruments Detected Displays the instruments connected to this application. Click on the instrument name to
open a list of available (detected) instruments.

Select Options > Instrument Control Settings and click Refresh to update the instrument
list.

Note: Verify that the GPIB search criteria (default setting) in the Instrument
Control Settings is selected when using TekExpress 100G-TXE application.

General Configuration

Ref Levels

Absolute Select to set the Ref Levels in Absolute
Percentage Select to set the Ref Levels in Percentage
Mid Level Select the mid level in absolute or percentage
Hysteresis Select the hysteresis in absolute or percentage

Bandwidth Select the bandwidth as Full BW or 50 GHz. By default Full BW is selected.

De-Embedding Filter Select to apply the de-embed filter file. Click Browse and select the de-embedding filter
files (.flt).

For single ended mode, select filter file for Data Positive and Data Negative.

• Source file name for data Positive
• Source file name for data negative

For Differential mode, select differential filter file.

• Differential source filter file name

Note: Browse option is enabled only when you select Use filter file for de-
embedding.

Phase Inverted Filter for Data- (using SDLA
with dual input mode)

Select this option if the filter is created from SDLA using Dual input option. The negative
channel filter must be phase inverted when you select this option.

Eye Configuration

Table continued…
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Setting Description
CTLE Filter File Select the CTLE Filter File.

Compliance mode

• All: Application will run through all CTLE filters from 1 dB - 9 dB (at TP1a) and 1 dB - 2
dB (at TP4)

• Best CTLE: After the first run, Best CTLE filter option gets enabled. User can run
the measurement with Best CLTE instead of looping through all CTLE filters in the
specification.

User Defined mode

• User can run the measurement with any specified CTLE filter. The application provides
CTLE filters from 0 dB - 9 dB for data rate of 25.78125 Gbps. It is recommended to
create custom CTLE filter files for any other data rates.

Select the CTLE filters from the drop-down list or Custom to browse and select the
custom CTLE filter files.

Note: Custom CTLE filter files is to be named in the format <user defined
name>_ndB.flt, where n is the gain of the filter.

Record Length for Eye measurements Select the record length for eye measurements. The available values are 20 M, 30 M, 40
M. By default 40 M is selected.

Note: This configuration is applicable for eye measurements only.

Target BER (1e-) Support the eye measurements at target BER other than 1e-15 in user-defined mode.

Note: This configuration is applicable for eye measurements only.

Jitter Configuration

Record Length for Jitter measurements Select the record length for jitter measurements. The available values are 20 M, 30 M, 40
M. By default 40 M is selected.

Note: This configuration is applicable for jitter measurements only.

Measurements - CAUI4 TXE

Analyze Measurement Range - 20%-80%

Note: This setting is applicable only for Transition time measurement.

Set preferences tab parameters
Use Preferences tab to set the application action on completion of a measurement. 
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Table 12: Preferences tab settings

Setting Description

Number of Runs

Acquire/Analyze each test <no>
times (not applicable to Custom
Tests)

Select to repeat the test run by setting the number of times. By default, it is selected with 1 run.

Actions on Test Measurement Failure

On Test Failure, stop and notify
me of the failure

Select to stop the test run on Test Failure, and to get notified via email. By default, it is unselected.

Click Email Settings to configure.

Popup Settings

Auto close Warnings and
Informations during Sequencing

Auto close after <no> Seconds

Select to auto close warnings/informations during sequencing. Set the Auto close time. By default it is
unselected.

Auto close Error Messages
during Sequencing. Show in
Reports

Auto close after <no> Seconds

Select to auto close Error Messages during Sequencing. Set the Auto close time. By default it is
unselected.
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Status panel: View the test execution status
The Status panel contains the Test Status and Log View tabs, which provides status on the test acquisition and analysis (Test Status) and
listing of test tasks performed (Log View tab). The application opens the Test Status tab when you start to execute the test. Select the
Test Status or the Log View tab to view these items while the test execution is in progress.

View test execution status
The tests are grouped and displayed based on the Clock and Data lane. It displays the tests along with the acquisition type, acquire, and
analysis status of the tests. In pre-recorded mode, Acquire Status is not valid.

The Test Status tab presents a collapsible table with information about each test as it is running. Use the symbols to expand ( ) and
collapse ( ) the table rows.

Figure 21: Test execution status view in Status panel

Table 13: Test execution status table headers

Table Header Description
Test Name Displays the measurement name.
Acquisition Describes the type of data being acquired.
Acquire Status Displays the progress state of the acquisition:

• To be started
• Started Acquisition
• Completed Acquisition

Table continued…

Status panel: View the test execution status
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Table Header Description
Analysis Status Displays the progress state of the analysis:

• To be started
• In Progress
• Completed

View test execution logs
The Test Status tab displays the detailed execution status of the tests. Also, displays each and every execution step in detail with its
timestamp information. The log details can be used to troubleshoot and resolve any issue/bug which is blocking the test execution process.

Figure 22: Log view in Status panel

Table 14: Status panel settings

Control Description
Message History Lists all the executed test operations and timestamp information.
Auto Scroll Enables automatic scrolling of the log view as information is added to the log during the test execution.

Clear Log Clears all the messages from the log view.
Save Saves the log file into a text file format. Use the standard Save File window to navigate to and specify

the folder and file name to save the log text.

Status panel: View the test execution status
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Results panel: View summary of test results
When a test execution is complete, the application automatically opens the Results panel to display a summary of test results.

In the Test Result table, each test result occupies a row. By default, results are displayed in summary format with the measurement details
collapsed and with the Pass/Fail column visible.

Figure 23: Results panel with measurement results

Click  icon on each measurement in the row to expand and to display the minimum and maximum parameter values of the
measurement.

Filter the test results
Each column in the result table can be customized and displayed by enabling or disabling any column as per your requirement. You can
change the view in the following ways:

• To remove or restore the Pass/Fail column, select Preferences > Show Pass/Fail.
• To collapse all expanded tests, select Preferences > View Results Summary.
• To expand all the listed tests, select View Results Details from the Preferences menu in the upper right corner.
• To enable or disable the wordwrap feature, select Preferences > Enable Wordwrap.
• To view the results grouped by lane or test, select the corresponding item from the Preferences menu.
• To expand the width of a column, place the cursor over the vertical line that separates the column from the column to the right. When

the cursor changes to a double-ended arrow, hold down the mouse button and drag the column to the desired width.
• To clear all test results displayed, click Clear.

Results panel: View summary of test results
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Plots panel
Plots panel overview
The Plots panel displays the result as a two-dimensional plot for additional measurement analysis. The plots are displayed only during run
and only for the measurements which supports plots.

Toolbar functions in plot windows
The Plot Toolbar window includes the following functions:

Icon Functions

Save

Saves the plot.

Select & Zoom
Expands the selected plot area. Left-click and drag the mouse to mark the region on the plot to zoom.

Zoom In
Expands part of the plot (Horizontal and Vertical); the data appears in more detail.

Zoom Out
Contracts part of the plot (Horizontal and Vertical); the data appears in less detail.

Pan
Moves the plot anywhere within the scale.

Hide Gridlines
Hides the gridlines.

Table continued…

Plots panel
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Icon Functions

Reset

Resets the zoom to 100%.

Choose Waveform Colors
Sets the plot color. Click and select the color in the Color window and click OK. Click in the plot area to
apply the color.

Show/Hide Markers

Displays or hides the markers

UnDock/Dock
Click to undock/dock the plot window.

Select Test Select the measurement.

Plots panel
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Reports panel: Configure report generation settings
Click Reports panel to configure the report generation settings and select the test result information to include in the report. You can use
the Reports panel to configure report generation settings, select test content to include in reports, generate the report, view the report,
browse for reports, name and save reports, and select report viewing options.

Select report generation options
This section describes the report generation settings you can configure in the Reports panel. Select report settings before running a test or
when creating and saving test setups. Report settings configured are included in saved test setups.

Figure 24: Reports panel

Report Update Mode Settings
Table 15: Report Update Mode Settings

Control Description
Generate new report Each time when you click Run and when the test execution

is complete, it will create a new report. The report can be in
either .mht, .pdf, or .csv file formats.

Append with previous run session Appends the latest test results to the end of the current test results
report. Each time when you click this option and run the tests, it will
run the previously failed tests and replace the failed test result with
the new pass test result in the same report.

Include header in appended reports Select to include header in appended reports.
Table continued…

Reports panel: Configure report generation settings
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Control Description
Replace current test in previous run session Replaces the previous test results with the latest test results.

Results from newly added tests are appended to the end of the
report.

In previous run, current session Select to replace current test results in the report with the test
result(s) of previous run in the current session.

In any run, any session Select to replace current test results in the report with the test
result(s) in the selected run session’s report. Click and select test
result of any other run session.

Report Creation Settings
Report name Displays the name and path of the <Application Name>

report. The default location is at \My Documents>\My
TekExpress\<Application Name>\Reports. The
report file in this folder gets overwritten each time you run a test
unless you specify a unique name or select to auto increment the
report name.

To change the report name or location, do one of the following:

• In the Report Path field, type the current folder path and name.
• Double-click in the Report Path field and then make selections

from the popup keyboard and click Enter.

Be sure to include the entire folder path, the file name,
and the file extension. For example: C:\Documents
and Settings\your user name\My
Documents\My TekExpress\<Application
Name> \DUT001.mht.

Note: You cannot set the file location using the Browse
button.

Open an existing report

Click Browse, locate and select the report file and then click View
at the bottom of the panel.

Save as type Saves a report in the specified file type, selected from the drop-
down list. The report is saved in .csv, .pdf, or .mht.

Note:

If you select a file type different from the default, be sure to
change the report file name extension in the Report Name
field to match.

Auto increment report name if duplicate Sets the application to automatically increment the name of the
report file if the application finds a file with the same name as the
one being generated. For example: DUT001, DUT002, DUT003.
This option is enabled by default.

Create report automatically at the end of the run Select to create the report with the settings configured, at the end of
run.

Table continued…
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Control Description
Contents To Save Settings
Include pass/fail info in details table Select to include pass/fail information in the details table of the

report.
Include detailed results Select to include detailed results in the report.
Include plot images Select to include the plot images in the report.
Include setup configuration Sets the application to include hardware and software information in

the summary box at the top of the report. Information includes: the
oscilloscope model and serial number, the oscilloscope firmware
version, and software versions for applications used in the
measurements.

Include complete application configuration Select to include the complete application configuration in the
report.

Include user comments Select to include any comments about the test that you or another
user have added in the DUT tab of the Setup panel. Comments
appear in the Comments section, below the summary box at the
beginning of each report.

Include statics table Select to include test run statistics in the report. This is enabled
when you run any test for more than once. Set Acquire/Analyze
each test in the Preferences tab to more than one, to run any test
for multiple times.

Other settings in report panel
View report after generating Automatically opens the report in a Web browser when the test

execution is complete. This option is selected by default.

View Click to view the most current report.
Generate Report Generates a new report based on the current analysis results.
Group Report By
Test Name Select to group the test results based on the test name in the report.
Test Result Select to group the test results based on the test result in the report.

Reports panel: Configure report generation settings
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View a generated report
Sample report and its contents
A report shows detailed results and plots, as set in the Reports panel.

Figure 25: Report from 100G-TXE

Setup Information The summary box at the beginning of the report lists setup configuration information. This information
includes the oscilloscope model and serial number, optical module model and serial number, and software
version numbers of all associated applications.

Test Name Summary Table The test summary table lists all the tests which are executed with its result status.
Measurement The measurement table displays the measurement related details with its parameter value.
User comments If you had selected to include comments in the test report, any comments you added in the DUT tab are

shown at the top of the report.

Reports panel: Configure report generation settings
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Saving and recalling test setup
Overview
You can save the test setup and recall it later for further analysis. Saved setup includes the selected oscilloscope, general parameters,
acquisition parameters, measurement limits, waveforms (if applicable), and other configuration settings. The setup files are saved under
the setup name at X:\

Figure 26: Example of Test Setup File

Use test setups to:

• Recall a saved configuration.
• Run a new session or acquire live waveforms.
• Create a new test setup using an existing one.
• View all the information associated with a saved test, including the log file, the history of the test status as it executed, and the results

summary.
• Run a saved test using saved waveforms.

Note: Images that are shown in this Saving and recalling test setup chapter are for illustration purpose only and it may vary
depending on the TekExpress application.

Save the configured test setup
You can save a test setup before or after running a test. You can create a test setup from already created test setup or using a default
test setup. When you save a setup, all the parameters, measurement limits, waveform files (if applicable), test selections, and other
configuration settings are saved under the setup name. When you select the default test setup, the parameters are set to the application’s
default value.

• Select Options > Save Test Setup to save the opened setup.

Saving and recalling test setup
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• Select Options > Save Test Setup As to save the setup with different name.

Load a saved test setup
To open (load) a saved test setup, do the following:

• Select Options > Open Test Setup.

Saving and recalling test setup
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• From the File Open menu, select the setup file name from the list and click Open.

Note: Parameters that are set for the respective test setup will enable after opening the file.

Perform a test using pre-run session files
Complete the following steps to load a test setup from a pre-run session:

1. Select Options > Open Test Setup.

Saving and recalling test setup

TekExpress® 100G-TXE Compliance Solution Application Help 51



2. From the File Open menu, select a setup from the list and then click Open.

Note: Parameters that are set for the respective test setup will enable after opening the file.

3. Switch the mode to Use Pre-recorded waveform files in the DUT panel.

Saving and recalling test setup
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4. Select the required waveforms from the selected setup in the Acquisitions tab and click Start.

5. The selected waveform file can be removed/replaced by clicking on the ( ) icon.

Saving and recalling test setup
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6. After successful completion of the test, the waveform report files are stored at X:\<Application Name>\Reports.

7. The overall test result status after completion of the test execution is displayed in the Results Panel.

Saving and recalling test setup
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Save the test setup with a different name
To save a test setup with a different name, follow the steps:

1. Select Options > Save Test Setup As.

2. Enter the new test setup name and click Save.

Saving and recalling test setup
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CAUI4 TXE compliance measurements
DC common mode output voltage
This section verifies that the mean of the common mode signal is within the conformable limits according to the specification.

Required test equipment

Minimum system requirements

Equipment connection diagram

Standards Test points Specification
CAUI4 TP1a IEEE 802.3bm, Section 83E.3.1.2, Table 83E-1

TP4 IEEE 802.3bm, Section 83E.3.1.2, Table 83E-3

Measurement procedure

The supported voltage range of ATI channel of the scope is ±0.3 V and the DC voltage of the DUT can be beyond the supported voltage
limits. Hence, use external digital multimeter to measure the voltage and enter it in the application.

Limits

At TP1a: -0.3 V to 2.8 V

At TP4: -0.35 V to 2.85 V

Diff peak-to-peak output voltage - Tx disabled
This section verifies that the peak-to-peak differential output voltage when the transmitter is disabled is within the conformable limits
according to the specification.

Required test equipment

Minimum system requirements

Equipment connection diagram

Standards Test points Specification
CAUI4 TP1a IEEE 802.3bm, Section 83E.3.1.2, Table 83E-1

Inputs

• Differential signal created using two single ended sources (Positive and Negative) without any filtering.

Measurement procedure

1. Add Peak-to-Peak measurement.
2. The value of the pk-pk voltage is the differential output voltage (pk-pk).

Limits

At TP1a:

• Lower limit: NA
• Higher limit: 35 mV

CAUI4 TXE compliance measurements
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Diff peak-to-peak output voltage - Tx enabled
This section verifies that the peak-to-peak differential output voltage is within the conformable limits according to the specification.

Required test equipment

Minimum system requirements

Equipment connection diagram

Standards Test points Specification
CAUI4 TP1a IEEE 802.3bm, Section 83E.3.1.2, Table 83E-1

TP4 IEEE 802.3bm, Section 83E.3.1.2, Table 83E-3

Inputs

• Differential signal created using two single ended sources (Positive and Negative) and filtered through fourth order 33 GHz Bessel
Thomson filter.

Measurement procedure

1. Add Peak-to-Peak measurement.
2. The value of the pk-pk voltage is the differential output voltage (pk-pk).

Limits

At TP1a and TP4:

• Lower limit: NA
• Higher limit: 900 mV

AC common mode output voltage
This section verifies that the RMS value of the common mode signal is within the conformable limits according to the specification.

Required test equipment

Minimum system requirements

Equipment connection diagram

Standards Test points Specification
CAUI4 TP1a IEEE 802.3bm, Section 83E.3.1.2, Table 83E-1

TP4 IEEE 802.3bm, Section 83E.3.1.2, Table 83E-3

Inputs

• Differential signal created using two single ended sources (Positive and Negative) and filtered through fourth order 33 GHz Bessel
Thomson filter.

Measurement procedure

1. Create a common mode signal using Math = (Data Positive + Data Negative)/2.
2. Create Vertical histogram on the common mode signal.
3. Add Standard deviation measurement.
4. Standard deviation of the signal is measured as AC common mode voltage.

Limits

CAUI4 TXE compliance measurements
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At TP1a and TP4:

• Lower limit: NA
• Higher limit: 17.5 mV

Single ended output voltage
This section verifies that the max and min of data positive and negative signals are within conformable limits as per the specification.

Required test equipment

Minimum system requirements

Equipment connection diagram

Standards Test points Specification
CAUI4 TP1a IEEE 802.3bm, Section 83E.3.1.2, Table 83E-1

Inputs

• Two single ended sources (Positive and Negative) filtered through fourth order 33 GHz Bessel Thomson filter.

Measurement procedure

1. Find the max and min of the signal using base scope measurement option (select Measure > Amplitude. Select Maximum and
Minimum).

2. Single Ended output voltage (max) = DC Common mode voltage + Max of Single Ended signal (without DC).
3. Single Ended output voltage (min) = DC Common mode voltage + Min of Single Ended signal (without DC).
4. Perform Step 2 on page 58 and 3 on page 58 on single ended data positive and data negative signals.

Limits

At TP1a:

• Lower limit: -0.4 V
• Higher limit: 3.3 V

Signaling rate
This section verifies that the signaling rate (data rate) of the DUT per lane is within the conformable limits according to the specification.

Required test equipment

Minimum system requirements

Equipment connection diagram

Standards Test points Specification
CAUI4 TP1a IEEE 802.3bm, Section 83E.3.1.1, Table 83E-1

TP4 IEEE 802.3bm, Section 83E.3.1.1, Table 83E-3

Inputs

• Differential signal created using two single ended sources (Positive and Negative) and filtered through fourth order 33 GHz Bessel
Thomson filter.

Measurement procedure

1. This measurement is performed using DPOJET Period measurement as prerequisite.

CAUI4 TXE compliance measurements
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2. Period is found edge to edge which gives the Unit interval (UI) of the signal.
3. The result of the period measurement (UI) is used to find the data rate of the signal. Data Rate = 1/Unit interval.

Limits

At TP1a and TP4:

• Lower limit: Configured Date Rate - 100 ppm
• Higher limit: Configured Date Rate + 100 ppm

Eye width and Eye height
This section verifies that the eye width and eye height are within the conformable limits according to the specification. 

Required test equipment

Minimum system requirements

Equipment connection diagram

Standards Test points Specification
CAUI4 TP1a IEEE 802.3bm, Section 83E.3.1.6, Table 83E-1

TP4 IEEE 802.3bm, Section 83E.3.2.1, Table 83E-3

Inputs

• Differential signal created using two single ended sources (Positive and Negative) and filtered through fourth order 33 GHz Bessel
Thomson filter.

Calibration:

Before running the Eye width / Eye height measurement, the below setup has to be calibrated with a crosstalk generator, as mentioned in
the following settings:

• For Host (TP1a): Calibrate the crosstalk generator at TP4 with target differential peak-to-peak amplitude of 900 mV and target
transition time of 12 ps (section 83E.3.1.6).

• For Module (TP4): Calibrate the crosstalk generator at TP1a with target differential peak-to-peak amplitude of 900 mV and target
transition time of 19 ps (section 83E.3.2.1).

Measurement procedure

Eye width and Eye height calculation

Signal is captured such that it has more than 1e6 edges. Measurements are done using Dual-Dirac jitter model as specified in section
83E.4.

EW15 = EW6 - 3.19*(RJR + RJL)

Where,

EW15 is the eye width extrapolated to 10-15 probability

EW6 is the eye width at 10-6 probability

RJL is the RMS value of the jitter estimated from CDFL

RJR is the RMS value of the jitter estimated from CDFR

EH15 = EH6 - 3.19*(RN0+RN1)

Where,

EH15 is the eye width extrapolated to 10-15 probability

CAUI4 TXE compliance measurements
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EH6 is the eye width at 10-6 probability

RN1 is the RMS value of the jitter estimated from CDF1

RN0 is the RMS value of the jitter estimated from CDF0

Compliance method to find Eye width and Eye height results

The signal filtered through Bessel Thomson filter is equalized using different CTLE filters (1 dB - 9 dB for Host) and (1 dB - 2 dB for
Module). CTLE filter result which has the maximum Eye area (Eye width * Eye height) and passing both Eye height and Eye width results
is chosen as reference CTLE filter.

Host (TP1a): The CTLE peaking in the reference receiver shall be set to three values:

1. The recommended CTLE peaking value provided by the host (CTLE 1 dB to 9 dB)
2. The value 1 dB higher if present
3. The value 1 dB lower if present

A compliant host should pass both the eye width and eye height A limit using at least one of the settings and passes eye height B in two or
three settings.

Module (TP4): A compliant module has to pass both eye width and eye height at least one of the CTLE settings (CTLE 1 dB to 2 dB).

Limits

At TP1a:

• Eye Width: LL: 0.46 UI and UL: NA

• Eye Height A: LL: 95 mV and UL: NA
• Eye Height B: LL: 80 mV and UL: NA

At TP4:

• Eye Width: LL: 0.57 UI and UL: NA

• Eye Height: LL: 228 mV and UL: NA

Vertical eye closure
This section verifies that the vertical eye closure of the signal is within the conformable limits according to the specification IEEE 802.3bm,
and Section 83E.4.2.1.

Required test equipment

Minimum system requirements

Equipment connection diagram

Standards Test points Specification
CAUI4 TP4 IEEE 802.3bm, Section 83E.4.2.1, Table 83E-3

Inputs

• Differential signal created using two single ended sources (Positive and Negative) and filtered through fourth order 33 GHz Bessel
Thomson filter.

Measurement procedure

1. The filtered signal is equalized using reference or best CTLE filter. If reference CTLE filter is not present, the application will loop
through required CTLE filters to find the reference CTLE filter.
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2. Eye height@BER of 1e-15 and Eye amplitude are calculated for the equalized signal using Dual-Dirac jitter separation model as
explained section 83E.3.2.1.

3. Vertical eye closure is calculated using the following formula:

VEC = 20log(AV/EH15)

Where,

VEC is vertical eye closure in dB

AV is the eye amplitude of the equalized waveform. Eye amplitude is defined as the mean value of logic one minus the mean value of
logic zero in the central 5% of the eye

EH15 is the eye height at BER of 1e-15

Limits

At TP4:

• Lower limit: NA
• Higher limit: 5.5 dB

Transition time
This section verifies that the transition time of the DUT is within the conformable limits according to the specification.

Required test equipment

Minimum system requirements

Equipment connection diagram

Standards Test points Specification
CAUI4 TP1a IEEE 802.3bm, Section 83E.3.1.5, Table 83E-1

TP4 IEEE 802.3bm, Section 83E.3.1.5, Table 83E-3

Inputs

• Differential signal created using two single ended sources (Positive and Negative) and filtered through fourth order 33 GHz Bessel
Thomson filter.

Measurement procedure

1. Measure the nominal Unit interval of the filtered signal.
2. For PRBS9, measure Voltage High in region 000001111 for Rise Time and Voltage Low in region 11111111100000 for fall time. Within

these regions, take average amplitude in -3 UI to -2 UI range from edge for finding voltage low. Also take average amplitude in 2 UI to
3 UI range from edge for finding voltage high.

3. Find the transition time in search patterns (000001111 for Rise and 11111111100000 for Fall) by taking difference in time from 20% to
80% of the signal amplitude.

Limits

At TP1a:

• Lower limit: 10 ps
• Higher limit: NA

At TP4:

• Lower limit: 12 ps
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• Higher limit: NA
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CR4 / KR4 TXE compliance measurements
DC common mode output voltage
This section verifies that the mean of the common mode signal is within the conformable limits according to the specification.

Standards Test points Specification
CR4 TP2 IEEE 802.3bj, Section 92.8.3.1, Table 92-6
KR4 TP0a IEEE 802.3bj, Section 93.8.1.3, Table 93-4

Required test equipment

Minimum system requirements

Equipment connection diagram

Measurement procedure

The supported voltage range of the scope is ±0.3 V and the DC voltage of the DUT can be beyond the supported voltage limits. Hence,
use external digital multimeter to measure the voltage and enter it in the application.

Limits

CR4 0 V to 1.9 V
KR4 0 V to 1.9 V

Diff peak-to-peak output voltage - Tx disabled
This section verifies that the peak to peak differential output voltage when transmitter is disabled is within the conformable limits according
to the specification.

Standards Test points Specification
CR4 TP2 IEEE 802.3bj, Section 92.8.3.1, Table 92-6
KR4 TP0a IEEE 802.3bj, Section 93.8.1.3, Table 93-4

Required test equipment

Minimum system requirements

Equipment connection diagram

Inputs

• Differential signal created using two single ended sources (Positive and Negative) without any filtering.

Measurement procedure

1. Add Peak to Peak measurement.
2. The value of the pk-pk voltage is measured as differential output voltage (pk-pk).

Limits

CR4 Peak-to-Peak Differential output (Tx Disabled) <= 35 mV
KR4 Peak-to-Peak Differential output (Tx Disabled) <= 30 mV
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Diff peak-to-peak output voltage - Tx enabled
This section verifies that the peak to peak differential output voltage is within the conformable limits according to the specification.

Standards Test points Specification
CR4 TP2 IEEE 802.3bj, Section 92.8.3.1, Table 92-6
KR4 TP0a IEEE 802.3bj, Section 93.8.1.3, Table 93-4

Required test equipment

Minimum system requirements

Equipment connection diagram

Inputs

• Differential signal created using two single ended sources (Positive and Negative) and filtered through fourth order 33 GHz Bessel
Thomson filter.

Measurement procedure

1. Add Peak to Peak measurement.
2. The value of the pk-pk voltage is measured as differential output voltage (pk-pk).

Limits

CR4 Peak-to-Peak Differential output <= 1200 mV
KR4 Peak-to-Peak Differential output <= 1200 mV

AC common mode output voltage
This section verifies that the RMS value of the common mode signal is within the conformable limits according to the specification.

Standards Test points Specification
CR4 TP2 IEEE 802.3bj, Section 92.8.3.1, Table 92-6
KR4 TP0a IEEE 802.3bj, Section 93.8.1.3, Table 93-4

Required test equipment

Minimum system requirements

Equipment connection diagram

Inputs

• Differential signal created using two single ended sources (Positive and Negative) and filtered through fourth order 33 GHz Bessel
Thomson filter.

Measurement procedure

1. Create a common mode signal using Math = (Data Positive + Data Negative)/2.
2. Create Vertical histogram on the common mode signal.
3. Add Standard deviation measurement.
4. Standard deviation of the signal is measured as AC common mode voltage.

Limits
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CR4 AC Common mode output voltage <= 30 mV RMS with respect to
ground

KR4 AC Common mode output voltage <= 12 mV RMS with respect to
ground

Signaling rate
This section verifies that the signaling rate (data rate) of the DUT per lane is within the conformable limits according to the specification.

Standards Test points Specification
CR4 TP2 IEEE 802.3bj, Section 92.8.3.9, Table 92-6
KR4 TP0a IEEE 802.3bj, Section 93.8.1.2, Table 93-4

Required test equipment

Minimum system requirements

Equipment connection diagram

Inputs

• Differential signal created using two single ended sources (Positive and Negative) and filtered through fourth order 33 GHz Bessel
Thomson filter.

Measurement procedure

1. This measurement is performed using DPOJET Period measurement as prerequisite.
2. Period is found edge to edge which gives the Unit interval (UI) of the signal.
3. The result of the period measurement (UI) is used to find the data rate of the signal. Data Rate = 1/Unit interval.

Limits

CR4 At TP1a and TP4:

• Lower limit: Configured Date Rate - 100 ppm
• Higher limit: Configured Date Rate + 100 ppm

KR4 At TP1a and TP4:

• Lower limit: Configured Date Rate - 100 ppm
• Higher limit: Configured Date Rate + 100 ppm

Output Jitter

Even-odd jitter peak to peak
This section verifies that the value of the even odd jitter is within the conformable limits according to the specification.

Standards Test points Specification
CR4 TP2 IEEE 802.3bj, Section 92.8.3.8, Table 92-6
KR4 TP0a IEEE 802.3bj, Section 93.8.1.7, Table 93-4

Required test equipment
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Minimum system requirements

Equipment connection diagram

Inputs

• Differential signal created using two single ended sources (Positive and Negative) and filtered through fourth order 33 GHz Bessel
Thomson filter.

Measurement procedure

1. Capture a long sequence of PRBS pattern.
2. Even Odd Jitter is measured as the magnitude of the difference between the average deviation of all even numbered transitions and

the average deviation of all odd numbered transitions, where even odd transitions are not possible transitions, but actual transitions.
3. The Even Odd Jitter is carried out by DPOJET using F/n measurement with n being set to 2.

Limits

CR4 Even Odd Jitter <= 0.035 UI
KR4 Even Odd Jitter <= 0.035 UI

Effective bounded and total uncorrelated jitter peak-to-peak
This section verifies that the jitter components are within the conformable limits according to the specification.

Standards Test points Specification
CR4 TP2 IEEE 802.3bj, Section 92.8.3.8, Table 92-6
KR4 TP0a IEEE 802.3bj, Section 93.8.1.7, Table 93-4

Required test equipment

Minimum system requirements

Equipment connection diagram

Inputs

• Differential signal created using two single ended sources (Positive and Negative) and filtered through fourth order 33 GHz Bessel
Thomson filter.

Measurement procedure

1. Capture PRBS signal with minimum of 2e3 edges present in the signal.
2. For calculating jitter application, consider the edges attached with long sequence of ones and zeros. This makes sure that the only

uncorrelated jitter is measured. Application performs this measurement with longer record length to get more accurate results.
3. EBUJ (Effective bounded uncorrelated jitter) and ERJ (Effective random jitter) are calculated from the signal using dual-dirac jitter

analysis as given in specification section 92.8.3.8.2.

Effective total uncorrelated jitter is calculated using the equation Effective total uncorrelated jitter = 7.9
* ERJ + EBUJ.

Limits

CR4 and KR4 Effective bounded uncorrelated jitter <= 0.1 UI peak-to-peak
Effective total uncorrelated jitter <= 0.18 UI peak-to-peak
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Signal to noise and distortion ratio
This section verifies that the signal to noise and distortion ratio of the DUT is within the conformable limits according to the specification.

Standards Test points Specification
CR4 TP2 IEEE 802.3bj, Section 92.8.3.7, Table 92-6
KR4 TP0a IEEE 802.3bj, Section 93.8.1.6, Table 93-4

Required test equipment

Minimum system requirements

Equipment connection diagram

Inputs

• Differential signal created using two single ended sources (Positive and Negative) and filtered through fourth order 33 GHz Bessel
Thomson filter.

Measurement procedure

1. Configure the DUT in OPTIMAL state and capture the signal for measurement.
2. Compute the Linear fit pulse response (Pmax) and the RMS value of the linear fit error σ(e) from the signal.
3. Measure the RMS deviation of voltage from the mean and denote it as (σ(n). This has to be measured at the flat portion of the

waveform where the slope is close to zero.
4. Signal to Noise an Distortion ratio is measured using below equation:

Limits

CR4 SNDR > 26 dB
KR4 SNDR > 27 dB

Transmitter waveform requirements

Common procedure for transmitter waveform requirements
This section describes the general procedure to be performed for Transmitter output waveform measurements. Perform the general
procedure and the measurement specific procedure for each sub-measurements.

Required test equipment

Minimum system requirements

Equipment connection diagram

Inputs

• Differential signal created using two single ended sources (Positive and Negative) and filtered through fourth order 33 GHz Bessel
Thomson filter.

Common procedure for transmitter waveform requirements

1. Configure the DUT to transmit the PRBS 7, 9, 11, or 15 signal continuously at the specified data rate.
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2. Acquire the signal at a sampling rate of 200 Gbps and record length of 5M samples.
3. Oversample the signal to get more than 32 samples per bit and average the signal across the PRBS patterns.
4. Process the signal using steps as per specification section 92.8.3.5 to measure the various Transmitter waveform parameters.

Linear fit pulse peak
This section verifies that the linear fit pulse peak value is within the conformable limits according to the specification.

Standards Test points Specification
CR4 TP2 IEEE 802.3bj, Section 92.8.3.5.2, Table 92-6
KR4 TP0a IEEE 802.3bj, Section 93.8.1.5.2, Table 93-4

Measurement procedure

1. Set the DUT in PRESET mode by setting the coefficients C(-1), C(0) and C(1) to zero.
2. Capture the signal and calculate linear fit filter coefficients of the signal. The peak value of the linear fit curve is measured as Linear Fit

pulse peak.

Limits

CR4 Linear Fit Pulse Peak > 0.45 * Steady state voltage
KR4 Linear Fit Pulse Peak > 0.71 * Steady state voltage

Steady state voltage
This section verifies that the steady state voltage is within the conformable limits according to the specification.

Standards Test points Specification
CR4 TP2 IEEE 802.3bj, Section 92.8.3.5.2, Table 92-6
KR4 TP0a IEEE 802.3bj, Section 93.8.1.5.2, Table 93-4

Measurement procedure

1. Set the DUT in PRESET mode by setting coefficients C(-1), C(0) and C(1) to zero.
2. Capture the signal and calculate linear fit pulse of the signal. The average value of the linear fit curve is measured as Steady state

output voltage (DC voltage) of the signal.

Limits

CR4 • Min: 0.34 V
• Max: 0.6 V

KR4 • Min: 0.4 V
• Max: 0.6 V

Minimum pre-cursor full scale ratio
This section verifies that the minimum pre-cursor equalization ratio is within the conformable limits according to the specification.

Standards Test points Specification
CR4 TP2 IEEE 802.3bj, Section 92.8.3.5.5, Table 92-6
Table continued…
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Standards Test points Specification
KR4 TP0a IEEE 802.3bj, Section 93.8.1.5.5, Table 93-4

Measurement procedure

1. Set the DUT in PRESET mode and compute the filter coefficients.
2. Calculate equalizer coefficients C(-1), C(0) and C(1). Minimum pre-cursor equalization ratio is calculated as below:

Min Pre-Cursor Eq Ratio = [C(0) – C(-1)] / [C(0) + C(-1)]
Limits

CR4 Minimum pre cursor equalization ratio >= 1.54
KR4 Minimum pre cursor equalization ratio >= 1.54

Minimum post-cursor full scale ratio
This section verifies that the minimum pre-cursor equalization ratio is within the conformable limits according to the specification.

Standards Test points Specification
CR4 TP2 IEEE 802.3bj, Section 92.8.3.5.5, Table 92-6
KR4 TP0a IEEE 802.3bj, Section 93.8.1.5.5, Table 93-4

Measurement procedure

1. Set the DUT in PRESET mode and compute the filter coefficients.
2. Calculate equalizer coefficients C(-1), C(0) and C(1). Minimum Post cursor equalization ratio is calculated as below:

Min Post-Cursor Eq Ratio = [C(0) – C(1)] / [C(0) + C(1)]
Limits

CR4 Minimum post cursor equalization ratio >= 4
KR4 Minimum post cursor equalization ratio >= 4

Normalized coefficient step size
This section verifies that the increment and decrement step size of transmitter equalizer coefficients (C(-1), C(0) and C(1)) of the DUT are
in conformable limits according to the specification.

Standards Test points Specification
CR4 TP2 IEEE 802.3bj, Section 92.8.3.5.4, Table 92-6
KR4 TP0a IEEE 802.3bj, Section 93.8.1.5.4, Table 93-4

Measurement procedure

C(-1) Increment step size and C(-1) Decrement step size:

1. Set the DUT in PRESET state; acquire the signal and calculate the filter coefficients.
2. Configure all the DUT’s transmitter equalizer coefficients to INITIALIZE state.
3. Measure the C(-1) coefficient value and denote as C(-1)_Initilaize
4. Configure the DUT’s transmitter equalizer coefficient C(-1) to INCREMENT, C(0) and C(1) to HOLD state.
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5. Measure the C(-1) coefficient value and denote as C(-1)_Increment
6. C(-1) Increment step size is calculated as: Δc = C(-1)_Increment – C(-1)_Initialize
7. Configure the DUT’s transmitter equalizer coefficient C(-1) to DECREMENT, C(0) and C(1) to HOLD state.
8. Measure the C(-1) coefficient value and denote as C(-1)_Decrement
9. C(-1) Increment step size is calculated as: Δc = C(-1)_Decrement – C(-1)_Increment

C(0) Increment step size and C(0) Decrement step size:

1. Set the DUT in PRESET state; acquire the signal and calculate the filter coefficients.
2. Configure all the DUT’s transmitter equalizer coefficients to INITIALIZE state.
3. Measure the C(0) coefficient value and denote as C(0)_Initilaize
4. Configure the DUT’s transmitter equalizer coefficient C(0) to INCREMENT, C(-1) and C(1) to HOLD state.
5. Measure the C(0) coefficient value and denote as C(0)_Increment
6. C(0) Increment step size is calculated as: Δc = C(0)_Increment – C(0)_Initialize
7. Configure the DUT’s transmitter equalizer coefficient C(0) to DECREMENT, C(-1) and C(1) to HOLD state.
8. Measure the C(0) coefficient value and denote as C(0)_Decrement
9. C(0) Increment step size is calculated as: Δc = C(0)_Decrement – C(0)_Increment

C(1) Increment step size and C(1) Decrement step size:

1. Set the DUT in PRESET state; acquire the signal and calculate the filter coefficients.
2. Configure all the DUT’s transmitter equalizer coefficients to INITIALIZE state.
3. Measure the C(1) coefficient value and denote as C(1)_Initilaize
4. Configure the DUT’s transmitter equalizer coefficient C(1) to INCREMENT, C(-1) and C(0) to HOLD state.
5. Measure the C(1) coefficient value and denote as C(1)_Increment
6. C(1) Increment step size is calculated as: Δc = C(1)_Increment – C(1)_Initialize
7. Configure the DUT’s transmitter equalizer coefficient C(1) to DECREMENT, C(-1) and C(0) to HOLD state.
8. Measure the C(1) coefficient value and denote as C(1)_Decrement
9. C(1) Increment step size is calculated as: Δc = C(1)_Decrement – C(1)_Increment

Limits

CR4 • Min: 0.0083
• Max: 0.05

KR4 • Min: 0.0083
• Max: 0.05

Coefficient initialization ratio
This section verifies that the equalizer coefficient initialization ratios (Initialization Ratio1 and Initialization Ratio2) of the DUT are within the
conformable limits according to the specification.

Standards Test points Specification
CR4 TP2 IEEE 802.3bj, Section 92.8.3.5.3
KR4 TP0a IEEE 802.3bj, Section 93.8.1.5.3

Measurement procedure
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1. Set the DUT in PRESET mode and compute the linear fit pulse.
2. Set the DUT in INITIALIZE mode and compute the linear fit pulse.
3. Compute the equalizer coefficients C(-1), C(0), and C(1) using linear fit impulse responses of PRESET and INITIALIZE modes.
4. Coefficient Initialization Ratio1 is calculated by the following formula:

Initialization Ratio1 = (c(0)+c(1)–c(–1))/(c(0)+c(1)+c(–1))
5. Coefficient Initialization Ratio2 is calculated by the following formula:

Initialization Ratio2 = (c(0)–c(1)+c(–1))/(c(0)+c(1)+c(–1))
Limits

CR4 and KR4 Coefficient Initialization Ratio1 1.29±10%
Coefficient Initialization Ratio2 2.57±10%
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SCPI Commands

About SCPI command
You can use the Standard Commands for Programmable Instruments (SCPI) to communicate remotely with the TekExpress application.
Complete the TCPIP socket configuration and the TekVISA configuration in the oscilloscope or in the device where you are executing the
script.

Note: If you are using an external PC to execute the remote interface commands, then install TekVISA in the PC to make the
configurations.

Socket configuration for SCPI commands
This section describes the steps to configure the TCPIP socket configuration in your script execution device and the steps to configure the
TekVISA configuration in the oscilloscope to execute the SCPI commands.

TCPIP socket configuration
1. Click Start > Control Panel > System and Security > Windows Firewall > Advanced settings.

2. In Windows Firewall with Advanced Security menu, select Windows Firewall with Advanced Security on Local Computer >
Inbound Rules and click New Rule…
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3. In New Inbound Rule Wizard menu

a. Select Port and click Next.

b. Select TCP as rule apply, enter 5000 for Specific local ports and click Next.
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c. Select Allow the connection and click Next.

d. Select Domain, Private, Public checkbox and click Next.
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e. Enter Name, Description (optional), and click Finish.

4. Check whether the Rule name is displayed in Windows Firewall with Advanced Security menu > Inbound Rules.

SCPI Commands

TekExpress® 100G-TXE Compliance Solution Application Help 75



TekVISA configuration
1. Click Start > All Programs > TekVISA > OpenChoice Instrument Manager.

2. Click Search Criteria. In Search Criteria menu, click LAN to Turn-on. Select Socket from the drop-down list, enter the IP address of

the TekExpress device in Hostname and type Port as 5000. Click  to configure the IP address with Port.

Enter the Hostname as 127.0.0.1 if the TekVISA and TekExpress application are in the same system, else enter the IP address of the
oscilloscope where the TekExpress application is running.
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3. Click Search to setup the TCPIP connection with the host. Check whether the TCPIP host name is displayed in OpenChoice
Instrument Manager > Instruments.

4. Double-click OpenChoice Talker Listener and enter the Command *IDN? in command entry field and click Query. Check that the
Operation is successful and Talker Listener Readout displays the Command / Data.
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Set or query the device name of application
This command sets or queries the device name of the application.

Syntax
TEKEXP:SELECT DEVICE,"<DeviceName>" (Set)

TEKEXP:SELECT? DEVICE (Query)

Command arguments
Argument Name Argument Type
<DeviceName> <String>

Returns
<String>

Examples
TEKEXP:SELECT DEVICE,"<DUT001>" command sets the device name of the application to DUT001.

TEKEXP:SELECT? DEVICE command returns the selected device name of the application.

Set or query the DUTID of application
This command sets or queries the DUTID of the application.

Syntax
TEKEXP:VALUE DUTID,"<Value>" (Set)

TEKEXP:VALUE? DUTID (Query)
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Command arguments
Argument Name Argument Type
<Value> <String>

Returns
<String>

Examples
TEKEXP:VALUE DUTID,"DUT001" command sets the DUTID of the application to DUT001.

TEKEXP:VALUE? DUTID command returns the DUTID of the application.

Set or query the suite name of the application
This command sets or queries the suite name of the application.

Syntax
TEKEXP:SELECT SUITE,"<SuiteName>" (Set)

TEKEXP:SELECT? SUITE (Query)

Command arguments
<SuiteName>

• TP1a, TP4 for CAUI4
• TP0a for CR4
• TP2 for KR4

Returns
<String>

Examples
TEKEXP:SELECT SUITE,"<SuiteName>" command sets the suite name of the application.

TEKEXP:SELECT? SUITE command returns the selected suite of the application.

Set or query the test name of the application
This command selects or deselects the specified test name of the application.

Syntax
TEKEXP:SELECT TEST,"<TestName>",<Value> (Set)

TEKEXP:SELECT TEST,"<ALL>" (Set)

TEKEXP:SELECT? TEST (Query)
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Command arguments
TestName Value
CAUI4

• DC Common Mode Output Voltage
• Diff Peak to Peak Output Voltage -Tx Disabled
• Diff Peak to Peak Output Voltage -Tx Enabled
• AC Common Mode Output Voltage
• Single Ended Output Voltage
• Signaling Rate
• Eye Width
• Eye Height Differential
• Transition Time
• Vertical Eye closure

{True | False} or {1 | 0}

It represents selected or unselected.

Where,

True or 1 - Selected

False or 0 - Unselected

KR4

• DC Common Mode Output Voltage
• Diff Peak to Peak Output Voltage -Tx Disabled
• Diff Peak to Peak Output Voltage -Tx Enabled
• AC Common Mode Output Voltage
• Single Ended Output Voltage
• Signaling Rate
• Linear Fit Pulse Peak
• Minimum Pre-cursor full scale ratio
• Minimum Post-cursor full scale ratio
• Normalized Coefficient Step Size
• Coefficient Initialization Ratio
• Signal To Noise And Distortion Ratio
• Steady State Voltage
• Even-Odd Jitter Peak to Peak
• Effective total uncorrelated jitter peak to peak
• Effective bounded uncorrelated jitter peak to peak

Table continued…
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TestName Value
CR4

• DC Common Mode Output Voltage
• Diff Peak to Peak Output Voltage -Tx Disabled
• Diff Peak to Peak Output Voltage -Tx Enabled
• AC Common Mode Output Voltage
• Single Ended Output Voltage
• Signaling Rate
• Linear Fit Pulse Peak
• Minimum Pre-cursor full scale ratio
• Minimum Post-cursor full scale ratio
• Normalized Coefficient Step Size
• Coefficient Initialization Ratio
• Signal To Noise And Distortion Ratio
• Steady State Voltage
• Even-Odd Jitter Peak to Peak
• Effective total uncorrelated jitter peak to peak
• Effective bounded uncorrelated jitter peak to peak

Returns
{True | False} or {1 | 0}

Examples
TEKEXP:SELECT TEST,"<TestName>",1 command selects the specified test in the Test Panel.

TEKEXP:SELECT TEST,"<ALL>" command select all the tests in the Test Panel.

TEKEXP:SELECT? TEST command returns the list of selected tests.

Set or query the version name of the application
This command sets or queries the version name of the application.

Syntax
TEKEXP:SELECT VERSION,”<VersionName>” (Set)

TEKEXP:SELECT? VERSION (Query)

Command arguments
Argument Name Argument Type Valid Values
<VersionName> <String> It is the name of the version on the DUT panel of the application.

Returns
<String>
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Examples
TEKEXP:SELECT VERSION,”<VersionName>” command sets the version name of application.

TEKEXP:SELECT? VERSION command returns the version name of application.

Set or query the general parameter values
This command sets or queries the general parameter values of the application.

Syntax
TEKEXP:VALUE GENERAL,"<ParameterName>","<Value>" (Set)

TEKEXP:VALUE? GENERAL,"<ParameterName>" (Query)

Command arguments

Table 16: Report panel command parameters

<ParameterName> <Value>
On Test Failure, stop and notify me of the failure {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Report Update Mode • New
• Append
• Replace

Report Path X:\<application name>\Reports\DUT001.mht

Save As Type • Web Archive (*.mht;*.mhtml)
• PDF (*.pdf;)
• CSV (*.csv;)

Auto increment report name if duplicate {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Table continued…
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<ParameterName> <Value>
Create report at the end {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Upload logo {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Include Pass/Fail Results Summary {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Include Detailed Results {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Include Plot Images {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Include Setup Configuration {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Table continued…
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<ParameterName> <Value>
Include Complete Application Configuration {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Include User Comments {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Report Settings:Include Header In Appended Reports {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

View Report After Generating {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Report Group Mode • Test Name
• Test Result
• Measurement Group

Append Report {True | False} or {1 | 0}

It represents selected or unselected.

Where,

• True or 1 - Selected
• False or 0 - Unselected

Returns
<NRf> or <String>

Examples
TEKEXP:VALUE GENERAL,"<ParameterName>","<Value>" command set the value for the specified general
parameter.
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TEKEXP:VALUE? GENERAL,"<ParameterName>" command returns the value for the specified general parameter.
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Set or query the acquire parameter values
This command sets or queries the acquire parameter values of the application.

Syntax
TEKEXP:VALUE
ACQUIRE,”<TestName>",”<AcquireType>”,”<ParameterName>","<ParameterValue>" (Set)

TEKEXP:VALUE? ACQUIRE,”<TestName>",”<AcquireType>”,”<ParameterName>" (Query)

Command arguments
Argument Name Argument Type Valid Values
<TestName> <String> It is the test name.
<AcquireType> <String> It is the acquire type.
<ParameterName> <String> It is the acquire parameter name.
<ParameterValue> <NRf> It is the acquire parameter value.

Returns
<Nrf>

Examples
TEKEXP:VALUE
ACQUIRE,”<TestName>",”<AcquireType>”,"<ParameterName>","<ParameterValue>" command sets
the value for the specified test and its acquire parameter.

TEKEXP:VALUE? ACQUIRE,”<TestName>",”<AcquireType>”,"<ParameterName>" command returns the
value for the specified test and its acquire parameter.

Set or query the analyze parameter values
This command sets or queries the analyze parameter values of the application.

Syntax
TEKEXP:VALUE ANALYZE,”<TestName>","<ParameterName>","<ParameterValue>" (Set)

TEKEXP:VALUE? ANALYZE,”<TestName>","<ParameterName>" (Query)

Command arguments
Test Name Parameter Name Parameter Value
Transition Time Measurement Range 10% - 90%

Returns
<Nrf>

Examples
TEKEXP:VALUE ANALYZE,”<TestName>","<ParameterName>","<ParameterValue>" command set the
value for the specified test and its analyze parameter.
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TEKEXP:VALUE? ANALYZE,”<TestName>","<ParameterName>" command returns the value for the specified test
and its analyze parameter.

Query the available devices in the DUT panel of the application
This command queries the list of available devices on the DUT panel as comma separated values.

Syntax
TEKEXP:LIST? DEVICE (Query)

Command arguments
Device Device Type and value Description
<Device> <String> It is the name of the device on the DUT panel of the application.

Returns
<String>

Examples
TEKEXP:LIST? DEVICE command returns the list of available devices.

Query the available suites for the selected device
This command queries the list of available suites for the selected device as comma separated values.

Syntax
TEKEXP:LIST? SUITE (Query)

Returns
<String>

Examples
TEKEXP:LIST? SUITE command returns the list of available suites for the selected device.

Query the list of available tests of the application
This command queries the list of available tests of the application for the selected device as comma separated values.

Syntax
TEKEXP:LIST? TEST (Query)
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Command arguments
TestName String
CAUI4 • DC Common Mode Output Voltage

• Diff Peak to Peak Output Voltage -Tx Disabled
• Diff Peak to Peak Output Voltage -Tx Enabled
• AC Common Mode Output Voltage
• Single Ended Output Voltage
• Signaling Rate
• Eye Width
• Eye Height Differential
• Transition Time
• Vertical Eye closure

KR4 • DC Common Mode Output Voltage
• Diff Peak to Peak Output Voltage -Tx Disabled
• Diff Peak to Peak Output Voltage -Tx Enabled
• AC Common Mode Output Voltage
• Single Ended Output Voltage
• Signaling Rate
• Linear Fit Pulse Peak
• Minimum Pre-cursor full scale ratio
• Minimum Post-cursor full scale ratio
• Normalized Coefficient Step Size
• Coefficient Initialization Ratio
• Signal To Noise And Distortion Ratio
• Steady State Voltage
• Even-Odd Jitter Peak to Peak
• Effective total uncorrelated jitter peak to peak
• Effective bounded uncorrelated jitter peak to peak

Table continued…
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TestName String
CR4 • DC Common Mode Output Voltage

• Diff Peak to Peak Output Voltage -Tx Disabled
• Diff Peak to Peak Output Voltage -Tx Enabled
• AC Common Mode Output Voltage
• Single Ended Output Voltage
• Signaling Rate
• Linear Fit Pulse Peak
• Minimum Pre-cursor full scale ratio
• Minimum Post-cursor full scale ratio
• Normalized Coefficient Step Size
• Coefficient Initialization Ratio
• Signal To Noise And Distortion Ratio
• Steady State Voltage
• Even-Odd Jitter Peak to Peak
• Effective total uncorrelated jitter peak to peak
• Effective bounded uncorrelated jitter peak to peak

Returns
<String>

Examples
TEKEXP:LIST? TEST command returns the list of available tests for the selected device.

Query the available version names of the application
This command queries the list of available version names of the application for the selected device as comma separated values.

Syntax
TEKEXP:LIST? VERSION (Query)

Returns
<String>

Examples
TEKEXP:LIST? VERSION command returns the list of version names for the selected device.

Query the list of available instruments based on the specified instrument type
This command queries the list of available instruments based on the specified instrument type.

Syntax
TEKEXP:LIST? INSTRUMENT,"<InstrumentType>" (Query)
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Command argument
Argument Name Argument value
<InstrumentType> <String>

Returns
<String>

Examples
TEKEXP:LIST? INSTRUMENT,"Real Time Scope" command returns the list of available instruments based on the real
time scope type.

Set or query the IP address of the instrument based on the specified instrument
type
This command sets or queries the IP address of the instrument based on the specified instrument type.

Syntax
TEKEXP:INSTRUMENT? "<InstrumentType>" (Query)

TEKEXP:INSTRUMENT, "<InstrumentType>","<Value>" (Set)

Command argument
Argument Name Argument Type
<InstrumentType> <String>
<Value> <String>

TCPIP::XXX.XX.XXX.XXX::INSTR

Returns
<String>

Examples
TEKEXP:INSTRUMENT? "<InstrumentType>" command returns the IP address of the oscilloscope.

TEKEXP:INSTRUMENT, "<InstrumentType>","<value>" command sets the oscilloscope to the specified IP address.

Query the information of the generated report file
This command queries the information of the generated report file in the format "<FileSize>","<FileName>".

Pre‐requisite
A session should be run earlier and the report should be generated to get the information of the report.

Syntax
TEKEXP:INFO? REPORT (Query)
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Returns
<FileSize>:: <String>

<FileName>:: <String>

Examples
TEKEXP:INFO? REPORT command returns the information of the generated report in the format ("1215”,"DUT001.mht”).

Query the information of the generated waveform files
This command queries the information of the generated waveform files in the format.

<File1Size,"File1Name”>.

If there are more than one waveform, the waveform file names are displayed with the comma separated values in the format

<File1Size,"File1Name">,<File2Size,"File2Name">.

Syntax
TEKEXP:INFO? WFM (Query)

Returns
<FileSize>:: <String>

<FileName>:: <String>

Examples
TEKEXP:INFO? WFM command returns the information of the generated waveform in the format (20000858,"X:\<Application
Name>\Untitled Session\DUT001\20200916_041609\Iter1_Short Record‐length for SCOPE Period_NoSSC_DIFF.wfm”).

Query the information of the generated image files
This command queries the information of the generated image files in the format.

<File1Size,"File1Name”>.

If there are more than one image, the image file names are displayed with the comma separated values in the format

<File1Size,"File1Name">,<File2Size,"File2Name">.

Syntax
TEKEXP:INFO? IMAGE (Query)

Returns
<FileSize>:: <String>

<FileName>:: <String>

Examples
TEKEXP:INFO? IMAGE command returns the information of the generated image
in the format (109058, "X:\<Application Name>\Untitled Session\DUT001\20200916_041609\Iter1_Short
Record‐length for SCOPE Period_NoSSC_DIFF.png";22794,"X:\<Application Name>\UntitledSession\DUT001\20
200916_041609\ScopePeriodPlot_Iteration1WithCursor.png").

SCPI Commands

TekExpress® 100G-TXE Compliance Solution Application Help 91



Query the active TekExpress application name
This command queries the active TekExpress application name running on the oscilloscope.

Syntax
TEKEXP:*IDN? (Query)

Returns
<String>

Examples
TEKEXP:*IDN? command returns the active TekExpress application name running on the oscilloscope.

Sets or query the acquire mode status
This command sets or queries the acquire mode status.

Syntax
TEKEXP:ACQUIRE_MODE <Mode> (Set)

TEKEXP:ACQUIRE_MODE? (Query)

Command arguments
Argument Name Argument value
<Mode> • LIVE

• PRE‐RECORDED

Returns
LIVE | PRE‐RECORDED

Examples
TEKEXP:ACQUIRE_MODE LIVE command sets the acquire mode to the Live mode.

TEKEXP:ACQUIRE_MODE? command returns the current acquire mode.

Set or query the execution mode status
This command sets or queries the execution mode status.

Syntax
TEKEXP:MODE <Mode> (Set)

TEKEXP:MODE? (Query)

Command arguments
Argument Name Argument value
<Mode> • COMPLIANCE

• USER‐DEFINED
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Returns
COMPLIANCE | USER‐DEFINED

Examples
TEKEXP:MODE COMPLIANCE command sets the execution mode to the compliance mode.

TEKEXP:MODE? command returns the current execution mode.

Generate the report for the current session
This command generates the report for the current session.

Syntax
TEKEXP:REPORT GENERATE(Set)

Arguments
N/A

Examples
TEKEXP:REPORT GENERATE command generates the report for the current session.

Query the value of specified report header field in the report
This command queries the value of specified report header field in the report.

Syntax
TEKEXP:REPORT? ”<Device Field>” (Query)

Command arguments
Argument Name Argument Type
<Device Field>

Device field is the header name of each field in the setup
information section of the report.

<String>

Returns
<String>

Examples
TEKEXP:REPORT? "DUT ID" command returns the value of DUT ID field in the report.

SCPI Commands

TekExpress® 100G-TXE Compliance Solution Application Help 93



Query the value of specified result detail available in report summary/details
table
This command queries the value of specified result detail available in report summary/details table.

Syntax
TEKEXP:RESULT? "<TestName>" (Query)

TEKEXP:RESULT? "<TestName>","<ColumnName>" (Query)

TEKEXP:RESULT? "<TestName>","<ColumnName>",<RowNumber> (Query)

Command arguments
Argument Name Argument Type
<TestName>

It is the test name of which the details are required in the report.

<String>

<ColumnName>

It is the column header name of which the details are required in the
report.

<String>

<RowNumber>

It is the row number of which the details are required in the report.

<String>

Returns
<String>

Examples
TEKEXP:RESULT? "<TestName>" will return the pass fail status of test.

TEKEXP:RESULT? "<TestName>","<ColumnName>" will return all the row values of specific column for the test with
comma separated values.

TEKEXP:RESULT? "<TestName>","<ColumnName>",<RowNumber> will return the column value of specified row
number.

Restore the setup to default settings
This command restores the setup to default settings.

Syntax
TEKEXP:SETUP Default (Set)

Arguments
N/A

Examples
TEKEXP:SETUP Default command restores the setup to default settings.
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Save the settings to a specified session
This command saves the settings to a specified session.

Syntax
TEKEXP:SETUP Save,"<SessionName>"
Command arguments
Argument Name Argument value
<SessionName> <String>

Examples
TEKEXP:SETUP Save,"<SessionName>" command saves the settings to a specified session.

Open the setup from a specified session
This command opens the setup from a specified session.

Syntax
TEKEXP:SETUP Open,"<SessionName>" (Set)

Command arguments
Argument Name Argument value
<SessionName> <String>

Examples
TEKEXP:SETUP Open,"<SessionName>" command opens the setup from a specified session.

Query the current setup file name
This command queries the current setup file name.

Syntax
TEKEXP:SETUP? CURRENT (Query)

Returns
<String>

Examples
TEKEXP:SETUP? CURRENT command returns the current setup file name.

Run/stop/pause/resume the selected measurements execution in the application
This command run/stop/pause/resume the selected measurements execution in the application.

Syntax
TEKEXP:STATE <operation mode> (Set)
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Command arguments
Argument Name Argument value
<operation mode> • RUN

• STOP
• PAUSE
• RESUME

Returns
RUN | STOP | PAUSE | RESUME

Examples
TEKEXP:STATE RUN command runs the execution for the selected measurements.

Query the current measurement execution status
This command queries the current measurement execution status.

Syntax
TEKEXP:STATE? (Query)

Returns
RUNNING | PAUSED | WAIT | ERROR | READY

Examples
TEKEXP:STATE? command returns the current measurement execution status.

Query whether the current setup is saved or not saved
This command queries whether the current setup is saved or not saved.

Syntax
TEKEXP:STATE? SETUP (Query)

Returns
Saved or Not‐Saved

Examples
TEKEXP:STATE? SETUP command returns whether the current setup is saved or not saved.

Query the status of the previous command execution
This command queries whether the previous command execution is completed successfully.

Syntax
TEKEXP:*OPC? (Query)
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Returns
{0 | 1} or {True | False}

1 or True indicates that command execution is successful.

0 or False indicates that command execution is failed.

Examples
TEKEXP:*OPC? command returns whether the previous command operation is completed successfully.

Query the last error occurred
This command queries the last error occurred.

Syntax
TEKEXP:LASTERROR? (Query)

Returns
<String>

Examples
TEKEXP:LASTERROR? command returns the last error occurred.

Set or query the popup details
This command sets or queries the popup details.

Syntax
TEKEXP:POPUP? (Query)

TEKEXP:POPUP "<PopupResponse>" (Set)

Command arguments
Argument Name Argument value
<PopupResponse> • Yes

• No

Returns
The pop‐up details return in the following format:

"<Tittle>","<message>","<response1>,<response2>".

Where,

<Tittle> :: <String>

<message> :: <String>

<response1>,<response2> :: <String>
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Examples
TEKEXP:POPUP? command returns the popup details in following format ": "Do you really want to exit TekExpress?";Responses: "Yes,
No".

TEKEXP:POPUP "Yes" command sets the popup response to Yes.

Query the enable or disable status of Continuous run function.
This command queries the enable or disable status of Continuous run function.

Syntax
TEKEXP:VALUE? GENERAL,"Enable Continuous Run" (Query)

Returns
{True | False} or {0 | 1}

Where,

1 or True indicates that the continuous run function is enabled.

0 or False indicates that the continuous run function is disabled.

Examples
TEKEXP:VALUE? GENERAL,"Enable Continuous Run" command returns the enable or disable status of continuous run
function.

Set or query the enable/disable status of Continuous Run function
This command sets or queries the enable/disable status of Continuous Run function.

Syntax
TEKEXP:VALUE ContinuousRun,"<Value>" (Set)

TEKEXP:VALUE? ContinuousRun (Query)

Arguments
Argument Name Argument value
<Value> {True | False} or {1 | 0}

It represents enabled or disabled.

Where,

• True or 1 - enabled
• False or 0 - disabled

Returns
{True | False} or {0 | 1}

Examples
TEKEXP:VALUE? ContinuousRun command returns the enable or disable status of Continuous run function.

TEKEXP:VALUE ContinuousRun,"<Value>" command enable or disable the Continuous run function.
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Set or query the continuous run duration time value
This command sets or queries the continuous run duration time value.

Syntax
TEKEXP:VALUE? ContinuousRun_Duration (Query)

TEKEXP:VALUE ContinuousRun_Duration,"<Value>" (Set)

Arguments
Argument Name Argument value
<Value> Infinite | hh:mm

Infinite sets the radio on button to infinite.

hh:mm sets the continuous run duration to the specified time in
hours and minutes. The minimum time duration you can set is
00:30.

Returns
Infinite | hh:mm

Examples
TEKEXP:VALUE? ContinuousRun_Duration command returns the continuous run duration time value.

TEKEXP:VALUE ContinuousRun_Duration,"<Value>" command sets the continuous run duration time value.

Set or query the session create option in the continuous run function
This command sets or queries the option for session creation in the continuous run function.

Syntax
TEKEXP:VALUE? ContinuousRun_RunSessionOptions (Query)

TEKEXP:VALUE ContinuousRun_RunSessionOptions,"Value" (Set)

Arguments
Argument Name Argument value
<Value> NewSession | SameSession_ClearResults

NewSession - creates new session for each run.

SameSession_ClearResults - Clears the test results of the current
session and starts the test execution. The session results will be
added in the same session, by erasing the previous run results.

Returns
NewSession | SameSession_ClearResults
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Examples
TEKEXP:VALUE? ContinuousRun_RunSessionOptions command returns the option for session creation in the
continuous run function.

TEKEXP:VALUE ContinuousRun_RunSessionOptions,"Value" command sets the option for session creation in the
continuous run function.

Set or query the View report after generating option status
This command sets or queries the enable/disable status of the View report after generating function.

Syntax
TEKEXP:VALUE? GENERAL,"View Report After Generating" (Query)

TEKEXP:VALUE GENERAL,"View Report After Generating",<value> (Set)

Arguments
Argument Name Argument value
<Value> {True | False} or {1 | 0}

It represents enabled or disabled.

Where,

• True or 1 - enabled
• False or 0 - disabled

Returns
{True | False} or {0 | 1}

Examples
TEKEXP:VALUE? GENERAL,"View Report After Generating" command returns the enable or disable status of
view report after generating option.

TEKEXP:VALUE GENERAL,"View Report After Generating",<value> command enable or disable the view
report after generating option.

Set or query the waveform file recalled for the specified test name and acquire
type
This command set or queries the waveform file recalled for the specified test name and acquire type.

If there are more than one waveform, the waveform file names are displayed with the symbol "$" separated values in the format

<WaveformFileName1$ WaveformFileName2>.

Syntax
TEKEXP:VALUE WFMFILE,<TestName>,<AcquireType>,<WaveformFileName> (Set)

TEKEXP:VALUE? WFMFILE,<TestName>,<AquireType> (Query)

Returns
<String>
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Examples
TEKEXP:VALUE WFMFILE,<TestName>,<AquireType>,<WaveformFileName> command recalls the sepcified
waveform file for the specified testname and acquire type.

TEKEXP:VALUE? WFMFILE,<TestName>,<AquireType> command returns the waveform file name recalled for the
specified testname and acquire type.

Set or query the enable/disable status of Verbose function
This command sets or queries the enable/disable status of Verbose function.

Syntax
TEKEXP:VALUE VERBOSE,"<Value>" (Set)

TEKEXP:VALUE? VERBOSE (Query)

Arguments
Argument Name Argument value
<Value> {True | False} or {1 | 0}

It represents enabled or disabled.

Where,

• True or 1 - enabled
• False or 0 - disabled

Returns
{True | False} or {0 | 1}

Examples
TEKEXP:VALUE VERBOSE,"<Value>" command enable or disable the Verbose function.

TEKEXP:VALUE? VERBOSE command returns the enable or disable status of Verbose function.

Sets or query the limit values in the limits editor window
This command sets or queries the limit values in the limits editor window.

Syntax
TEKEXP:VALUE LIMIT,<TestName>,<LimitHeader>,<Value1>,<CompareString>,<Value2>(Set)

TEKEXP:VALUE? LIMIT,<TestName>,<LimitHeader> (Query)

Returns
<String> or <NRf>

Examples
TEKEXP:VALUE LIMIT,<TestName>,<LimitHeader>,<Value1>,<CompareString>,<Value2> command
sets the limits value for the specified testname and limit header.
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TEKEXP:VALUE? LIMIT,<TestName>,<LimitHeader> command returns the limits value for the specified testname and
limit header.

Exit or close the application
The command exits or close the application

Syntax
TEKEXP:EXIT(Set)

Examples
TEKEXP:EXIT command close the application.

Examples
This section provides the examples for the SCPI commands.

Example Description
TEKEXP:*IDN? It returns the active TekExpress application name running on the scope.
TEKEXP:*OPC? It returns the last command execution status, if status is executed it returns "1" else "0".
TEKEXP:SELECT TEST + ParameterName+ "," + value
TEKEXP:ACQUIRE_MODE PRE-
RECORDED

It sets the acquire mode as pre-recorded.

TEKEXP:ACQUIRE_MODE? It returns LIVE when acquire mode is set to live or it returns pre-recorded when acquire
mode is set to pre-recorded.

TEKEXP:EXPORT REPORT It returns the report file in bytes. This can be written into another file for further analysis.
TEKEXP:INFO? REPORT It returns “100,”ReportFileName.mht”", when 100 is the file size in bytes for the filename

ReportFileName.
TEKEXP:INFO? WFM It returns “100,“WfmFileName1.wfm”";“200, “WfmFileName2.wfm”" when 100 is the filesize

in bytes for the filename WfmFileName1.wfm and 200 is the file size in bytes for the
filename WfmFileName2.wfm.

TEKEXP:INSTRUMENT "Real
Time Scope",DPO73304SX
( GPIB8::1::INSTR)

It sets the instrument value as DPO73304SX( GPIB8::1::INSTR ) for the selected
instrument type Real Time Scope.

TEKEXP:INSTRUMENT? "Real
Time Scope"

It returns "DPO73304SX ( GPIB8::1::INSTR ), when DPO73304SX ( GPIB8::1::INSTR )" is
the selected instrument for the instrument type Real Time Scope.

TEKEXP:LASTERROR? It returns ERROR: INSTRUMENT_NOT_FOUND, when no instrument is found.
TEKEXP:LIST? DEVICE It returns "USB4" when TX-Device, RXDevice are the available device.
TEKEXP:LIST?
INSTRUMENT,"Real Time
Scope"

It returns "DPO73304SX ( GPIB8::1::INSTR ), DPO73304DX ( TCPIP::
134.64.248.91::INSTR )" when DPO73304SX ( GPIB8::1::INSTR ), DPO73304DX
( TCPIP::134.64.248.91::INSTR ) are the list of available instruments.

TEKEXP:MODE COMPLIANCE It sets the execution mode as compliance.
TEKEXP:MODE? It returns COMPLIANCE when the execution mode is compliance or It returns USER-

DEFINED when the execution mode is user defined.
TEKEXP:POPUP OK It sets OK as the response to active popup in the application.
Table continued…
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Example Description
TEKEXP:POPUP? It returns "OK", when OK is the active popup information shown in the application.
TEKEXP:REPORT GENERATE It generates report for the current session.
TEKEXP:REPORT? "Scope Model
Number"

Returns "DPO73304SX" when DPO73304SX is the scope model.

TEKEXP:REPORT? DUT ID It returns "DUT001" when DNI_DUT001 is the DUT ID.
TEKEXP:RESULT? "Total
Jitter"

It returns Pass when the test result is Pass.

TEKEXP:RESULT? "Total
Jitter",1

It returns the 2nd Sub measurements Margin L and H values.

TEKEXP:SELECT DEVICE, USB4,
TRUE

It selects USB4.

TEKEXP:SELECT? DEVICE It returns USB4
TEKEXP:SETUP DEFAULT It restores the application to default setup.
TEKEXP:STATE STOP It stops the test execution.
TEKEXP:STATE? It returns as READY when the application is ready to run next measurement.
TEKEXP:STATE? SETUP It returns as NOT_SAVED when the current setup is not saved else it returns SAVED.
TEKEXP:VALUE GENERAL,"Test
Method","DPOJET"

It sets the Test Method parameter value to DPOJET.

TEKEXP:VALUE? GENERAL,"Test
Method"

It returns "DPOJET" when DPOJET is the Test Method value.

TEKEXP:SELECT TEST ,"Total
Jitter",True

Execute this command to select an individual test. This command will select "Total Jitter"
test in the Signal Test tab.
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References

Application directories
You can find the application files at C:\Program Files\Tektronix\<Application Name>. The application directory and associated files are
organized as follows:

The following table lists the default directory names and their usage:

Table 17: Application directories and usage

Directory names Usage

Bin Contains application libraries

Compliance Suites Contains test suite specific files

Examples Contains various support files

ICP Contains instrument and application specific interface libraries

Images Contains images of the application

Lib Contains utility files specific to the application

Report Generator Contains style sheets for report generation

Tools Contains instrument and application specific files

References

TekExpress® 100G-TXE Compliance Solution Application Help 104



File name extensions
The TekExpress <Application Name> software uses the following file name extensions:

Table 18: File name extension

File name extension Description
*.TekX Application session files (the extensions may not be displayed)
*.py Python sequence file.
*.xml Test-specific configuration information (encrypted) files.

Application log files

*.csv Test result reports

Plot data

*.mht Test result reports (default)

Test reports can also be saved in HTML format

*.pdf Test result reports

Application help document

*.xslt Style sheet used to generate reports
*.png Captured images

View test-related files
Files related to tests are stored in My Documents\<Application Name>\Untitled session folder. Each test setup in this folder has both a test
setup file and a test setup folder, both with the test setup name. The test setup file is preceded by the TekExpress icon.

Inside the test setup folder is another folder named for the DUT ID used in the test sessions. The default is DUT001.

Inside the DUT001 folder are the session folders and files. Each session also has a folder and file pair, both named for the test session
using the naming convention (date)_(time). Each session file is stored outside its matching session folder:

Each session folder contains image files of any plots generated from running the test session. If you selected to save all waveforms or ran
tests using prerecorded waveform files, these are included here.
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The first time you run a new, unsaved session, the session files are stored in the Untitled Session folder located at X: \<Application Name>.
When you name and save the session, the files are placed in a folder with the name that you specify. A copy of the test files stay in the
Untitled Session folder until you run a new test or until you close the application.

Parameters

About application parameters
This section describes the 100G-TXE application parameters, and includes the default menu settings.

The parameters for the menus, and options list the selections available for each and include the default values.

Setup panel configuration parameters

DUT tab parameters
Parameters Selection Default Setting

DUTID - DUT001

Mode Compliance, User defined Compliance

Standard CAUI4, KR4, CR4 CAUI4

Test Points for CAUI4 TP1a, TP4 TP1a
for KR4 TP0a TP0a
for KR4 TP2 TP2

Device Profile

Data Rate 18 GBd to 28.05 Gbps 25.78125 Gbps

Pattern Type PRBS7, PRBS9, PRBS11,
PRBS15

PRBS9

Source Differential, Single Ended Single Ended

Crosstalk Source Select, De-select De-select
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Test Selection tab parameters
Parameters Selection Default Setting

CAUI4 Tx • DC Common Mode Output Voltage
• Diff Peak to Peak Output Voltage Tx

Disabled
• Diff Peak to Peak Output Voltage Tx

Enabled
• AC Common Mode Output Voltage
• Single Ended Output Voltage
• Signaling Rate
• Transition Time
• Eye Width
• Eye Height Differential

All measurements selected

KR4 Tx and CR4 Tx • DC Common Mode Output Voltage
• Diff Peak to Peak Output Voltage -Tx

Disabled
• Diff Peak to Peak Output Voltage -Tx

Enabled
• AC Common Mode Output Voltage
• Single Ended Output Voltage
• Signaling Rate
• Linear Fit Pulse Peak
• Minimum Pre-cursor full scale ratio
• Minimum Post-cursor full scale ratio
• Normalized Coefficient Step Size
• Coefficient Initialization Ratio
• Signal To Noise And Distortion Ratio
• Steady State Voltage
• Even-Odd Jitter Peak to Peak
• Effective total uncorrelated jitter peak to

peak
• Effective bounded uncorrelated jitter

peak to peak

All measurements selected

Configuration tab parameters
Table 19: Global settings parameters

Parameters Selection Default Setting

Ref Levels

Absolute, Percentage Absolute, Percentage Percentage

Table continued…

References

TekExpress® 100G-TXE Compliance Solution Application Help 107



Parameters Selection Default Setting

Mid Level -10 mV to 10 mV 0 mV, 50%

Hysteresis 0 mV to 5 mV 2 mV, 5%,

Bandwidth Full BW, 50 GHz Full BW

Record Length for Jitter measurements 20M, 30M, 40M 40 M

De-embedding Filter Select, De-select De-select

Table 20: Measurement parameters

Parameters Selection Default Setting

CAUI4 Tx Transition Time Analyze Measurement Range 20%-80%, 10%-90% 20%-80%

Preferences tab parameters
Parameters Selection Default Setting
Acquire/Analyze each test X times 1 to 100 1

Auto close Warnings and Information during
Sequencing

Auto close after X Seconds

1 to 300 10

Auto close Error Messages during
Sequencing, Show in Reports

Auto close after X Seconds

1 to 300 10

Reports panel parameters
Parameters Selection Default Setting
Report name - X:\100G-TXE\Reports\DUT001.mht
Save as Type PDF (*.pdf;), Web Archive (*.mht; *.mhtml),

CSV (*.csv;)
Web Archive (*.mht; *.mhtml)

References
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